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Experiment AMe-1: Small Animal Respiratory Exchange Ratio (RER)

Background

There are two main sources of energy available for animal metabolism: carbohydrates (CHO) and fats. 

These molecules are broken down, or catabolized, into carbon dioxide, water, and energy. However, the

oxidation of fats requires more oxygen than the oxidation of carbohydrates. 

The oxidation of a molecule of carbohydrate is expressed by the following equation:

6 O
2
 + C

6
H

12
O

6
 = 6 CO

2
 + 6 H

2
O + 38 ATP 

As shown in this equation, 6 molecules of carbon dioxide are produced for every 6 molecules of 

oxygen consumed during the oxidation of carbohydrates, a ratio of 1.0.

The oxidation of a molecule of fatty acid is expressed by this equation:

23 O
2
 + C

16
H

32
O

2
 = 16 CO

2
 + 16 H

2
O + 129 ATP

As shown in this equation, 16 molecules of CO
2
 are produced for every 23 molecules of O

2
 consumed 

during the oxidation of fatty acids, a ratio of 0.7.

The energy requirements of the animal are met with a mixture of energy derived from carbohydrates 

and fats. The activity being performed determines the proportion of carbohydrates and fats being 

utilized. At rest, a body derives about 40% of its energy from carbohydrates and 60% from fats. As the 

intensity of activity increases, the demand for energy increases, and a greater proportion of this demand

is met by the oxidation of carbohydrates because the catabolism of fat is too slow to supply the amount 

of energy required.

As the ratio of energy supplied by fats and carbohydrates shifts during changes in activity, the ratio of 

carbon dioxide produced to oxygen consumed also shifts. The ratio of carbon dioxide produced to 

oxygen consumed during cellular metabolism can be measured by determining the changes in the 

concentrations of oxygen and carbon dioxide in the air that passes into and out of the organism being 

studied.

Homeothermic or endothermic (warm-blooded) animals and poikilothermic or ectothermic (cold-

blooded) animals have a metabolic rate related to body mass at a slope of 0.75. These organisms will 

show very different metabolic rates based on the way they maintain their body temperatures. 

Endotherms have a constant body temperature and maintain this elevated temperature by endogenous 

heat production. They tend to have a high VO2, high heat production, low thermal conductivity (good 

insulation) and a high metabolism - up to 5 times the metabolism of ectotherms. Ectotherms or 

poikilotherms base their internal body temperature on the thermal condition outside their bodies. Their 

body temperatures are high in warm environments, but low in cool environments. They adjust body 

temperature by means other than heat production and heat loss - thus having a lower overall 

metabolism than endotherms. Ectothermic animals tend to have a low VO2, low heat production and 

are poorly insulated (Figure AMe-1-B1).
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Figure AMe-1-B1: Chart showing the way body temperature fluctuates in ecto- and endothermic 

organisms.

In these animals, the amounts of oxygen consumed and carbon dioxide produced are measured using an

oxygen/carbon dioxide gas analyzer connected to a small animal chamber. The gas analyzer measures 

the concentration of oxygen consumed and carbon dioxide produced by the organism in the chamber. 

When the concentrations and volumes are brought together in a series of equations, the volume of 

oxygen consumed per minute, known as VO
2
, and the volume of carbon dioxide produced per minute, 

known as VCO
2
 are determined. The ratio of VCO

2
/VO

2
 is the Respiratory Exchange Ratio (RER), 

which can be used to determine the proportion of carbohydrates and fats utilized, and the energy 

expended per liter of oxygen consumed, during an activity (Table AMe-1-B1). 

The fat and carbohydrate percentages utilized during an activity are determined using the following 

equations:

((1.00-RER)/(1.00-0.70)) x 100 = %Fat utilized

100% - %Fat utilized = %CHO utilized

The energy expended during an activity is calculated from the RER and the volume of oxygen 

consumed. For example, if the RER is 0.90, the energy expended is 4.92kcal/liter O
2
. 

If 2.5 liters of oxygen are consumed per minute for 20 minutes, a total of 246 kcal are expended during 

the activity:

(2.5LO
2
/minute)(20min)(4.92kcal/liter O

2
) = 246kcal 
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At less intense activity levels, the rates of energy expenditure and RER values are lower. To expend the 

same amount of energy at a less intense level of activity, the duration of activity must be longer. For 

example, if the RER is 0.80, the energy expended is 4.80kcal/liter O
2
. If 1.7 liters of oxygen are 

consumed per minute, 8.16kcal are expended per minute:

(1.7LO
2
/minute)(4.80kcal/liter O

2
) = 8.16kcal/min 

To expend 246 kcal at a rate 8.16kcal/min would require 30 minutes, 9 seconds:

246 kcal/(8.16 kcal/min) = 30.15 minutes.

Table AMe-1-B1: Respiratory Exchange Ratio (RER) as a Function of the Proportions of Energy 

Sources.

RER
Energy

kcal/liter O
2

% Energy from CHO % Energy from Fats

0.70 4.69 0 100

0.75 4.74 15.6 84.4

0.80 4.80 33.4 66.6

0.85 4.86 50.7 49.3

0.90 4.92 67.5 32.5

0.95 4.99 84.0 16.0

1.00 5.05 100 0

In this experiment, students will measure the expired CO
2 

and consumed O
2
values, RER, and 

proportion of fat and carbohydrates utilized while an endotherm (mouse or rat) is in the small animal 

chamber. They will repeat the experiment with an ectothermic organism (frog, snake or lizard) and 

make a comparison between the RER values of these two types of animals. Students will then be able 

to make an accurate assessment of the metabolic capability of these organisms. These measurements 

will be performed quickly and easily using an iWorx GA-200 or GA-300 CO
2
/O

2
 gas analyzer. 

As an additional calculation, students can adjust the values for CO
2
 and O

2
 using Body Weight 

Normalization and Effective Mass Correction. CO
2
 and O

2
 values are normalized with respect to the 

animal’s body weight and corrected according to an effective mass value. Using a value of 1.0 will 

eliminate any effective mass correction, if desired.
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Experiment AMe-1: Small Animal Respiratory Exchange Ratio (RER)

Equipment Required

PC or Mac Computer

iWorx data acquisition unit and power supply

USB cable

Small Animal Chamber

Gas sample tubing

GA-300 CO
2
/O

2
 gas analyzer with filter

Calibration Kit

Barometer and thermometer

Mouse or Rat

Snake, Frog or Medium sized Lizard

Balance or scale

IXTA Setup

1. Place the IXTA on the bench, close to the computer.

2. Check Figure T-1-1 in the Tutorial for the location of the USB port and the power socket on the 

IXTA.

3. Check Figure T-1-2 in the Tutorial for a picture of the IXTA power supply.

4. Use the USB cable to connect the computer to the USB port on the rear panel of the IXTA. 

5. Plug the power supply for the IXTA into the electrical outlet. Insert the plug on the end of the 

power supply cable into the labeled socket on the rear of the IXTA. Use the power switch to 

turn on the unit. 

6. Confirm that the red power light is on.

Start the Software

1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is 

not available, click on the Windows Start menu, move the cursor to All Programs and then to 

the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window 

will appear as the program is opens.

2. On the Main window, pull down the Settings menu and select Load Group.

3. Locate the folder that contains the settings group, IPLMv6Complete.iwxgrp. Select this group 

and click Open.

4. Pull down the Settings menu, again. Select the SmallAnimalRER-GA300 settings file from the 

Animal Metabolism settings folder.

5. After a short time, LabScribe will appear on the computer screen as configured by the 
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SmallAnimalRER-GA300 settings.

6. For your information, the settings used to configure the LabScribe software and the IXTA unit 

for this experiment are programmed on the Preferences Dialog window which can be viewed by

selecting Preferences from the Edit menu on the LabScribe Main window.

7. Once the settings file has been loaded, click the Experiment button on the toolbar to open any 

of the following documents:

• Appendix

• Background

• Labs

• Setup (opens automatically)

Setup the Metabolic Cart

1. Locate the small animal chamber in the iWorx kit (Figure AMe-1-S1).

Figure AMe-1-S1: The small animal chamber with a endothermic animal inside.

2. Locate GA-300 gas analyzer, the gas analyzer power supply, two sensor output cables, a gas 

inlet filter, and gas sampling tubing in the iWorx kit (Figure AMe-1-S2).

3. Position the gas analyzer on the desktop, so that the analyzer can be connected to the data 

recording unit and the small animal chamber at the same time.

4. Plug one end of the BNC-BNC cable into the CO2 output on the front panel of the GA-300 

analyzer. Plug the other end of the cable into Channel A4 of the IXTA.

5. Plug one end of the DIN8-DIN8 cable into the O2 output on the front panel of the GA-300 

analyzer and the other end into Channel A5 of the IXTA.

6. Place the clear end of the Nafion tubing on the gas sampling port near one of the Luer-lock 

connectors on the small animal chamber.

7. Place the filter on the inlet port on the rear panel of the gas analyzer (Figure AMe-1-S4). Attach 

the braided end of the Nafion tubing to the filter.

8. Place the second gas sampling tube on the outlet port of the GA-300 analyzer and connect it to 

the other Luer-Lock connection on the small animal chamber.
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Figure AMe-1-S2: Small animal chamber, GA-300 and the iWorx IXTA showing the proper connections

to measure O
2
 and CO

2
 exchange.

Figure AMe-1-S3: The front panel of the GA-300 gas analyzer showing the connections for CO2 and 

O2, the on/off switches, and the power adapter connection. 

Figure AMe-1-S4: The rear panel of the GA-300 gas analyzer with the gas inlet ports.

Calibrating the Gas Analyzer

The gas analyzer is calibrated and checked at the factory and has the ability to measure and record both

oxygen and carbon dioxide concentrations over the ranges normally recorded from human and animal 

subjects.
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However, prior to use, users must perform a two-point calibration of the oxygen and carbon dioxide 

sensors.

The recommended gas mixtures include:

• 12% O
2
 and 5% CO

2
 with the balance of the mixture being N

2
; or,

• 16%  O
2
 and 4% CO

2 
with the balance of the mixture being N

2
. 

Room air can provide both the high concentration of O
2 

at 20.90%, and the low concentration of CO
2
, 

0.04%. 

Note: Warm up the gas analyzer for at least 30 minutes. The input Air Filter must be connected to 

avoid damaging the sensors.

Record the Voltage Outputs of the Gas Sensors

1. Turn on the gas analyzer for at least 30 minutes before performing a calibration.

2. Prepare the equipment that will deliver any gas samples, other than room air, to the GA-300:

• Clamp and secure any gas cylinders that will used to provide gas samples near the gas 

analyzer.

• Attach the regulator to the gas cylinder safely. 

• Attach a Luer-Lock connector to the outlet of the regulator that will allow the 

Calibration Kit for the gas analyzer to be connected to the regulator of the gas cylinder.

• Open the primary and secondary valves of the regulator for a few seconds to purge the 

air from the regulator.

• Close the secondary valve on the regulator to stop the flow of gas from the regulator. 

You will need the cylinder for the second sample of gas.

3. Attach a filter to the inlet port on the gas analyzer. Attach the braided end of the sampling 

tubing to the inlet of the filter.

4. Attach the clear tubing from the outlet port on the gas analyzer to the small animal chamber.

5. Measure the voltage outputs of the oxygen and carbon dioxide sensors when measuring a 

sample of room air.

6. Place the gas sampling tubing away from the users to prevent the sampling of exhaled air. 

Allow room air to be pumped through the gas analyzer for 10 seconds before recording the 

outputs of the sensors.

• Type Room Air in the Mark box to the right of the Mark button.

• Click on the Record button. The recording should scroll across the screen.

• While recording, press the Mark button to mark the recording with information about the

room air gas sample. 

• Record the outputs of the two gas sensors for about ten seconds. The recording which 

should be like the first segment of data in Figure AMe-1-S6.
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• Continue to record while moving to the next series of steps.

6. Measure the voltage outputs of the oxygen and carbon dioxide sensors when measuring a 

second sample of a gas mixture containing known concentrations of oxygen and carbon dioxide.

• Open the secondary valve on the regulator of the cylinder providing the second gas 

sample. Adjust the flow rate to low.

• While the gas sample is flowing from the regulator, connect the gas sample tubing of the

A-CAL-150 Calibration Kit (Figure AMe-1-S5) to the Luer-Lock connector on the 

output of the regulator. 

Figure AMe-1-S5: Calibration Kit A-CAL-150

• Connect the outlet from the A-CAL-150 Calibration Kit to the inlet filter port on the gas 

analyzer. The gas analyzer will pull the air in from the calibration kit.

• Type Gas Sample in the Mark box.

• While continuing to record with the sample gas flowing into the gas analyzer, press the 

Mark button to mark the recording with information about the second gas sample. 

7. Once the recordings of the gas concentrations reach a steady level, record for another ten 

seconds. 

8. This may take a minute or so.

9. Click the Stop button.

10. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 

in which to save the file, like your lab group folder). Designate the file type as *.iwxdata. Click 

on the Save button to save the data file.

Convert the Units on Gas Concentration Channels

1. Use the Display Time icons to adjust the Display Time of the Main window to show the 

complete calibration data on the Main window at the same time. The required data can also be 

selected by:

• Placing the cursors on either side of data required.
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2. Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the entire 

segment of data to the width of the Main window.

3. Click the 2-Cursor icon (Figure AMe-1-S7) so that two blue cursors appear on the Main 

window. Place one cursor on the section of data recorded when gas analyzer was collecting a 

sample of room air and the second cursor on the section of data recorded when the second 

sample was collected.

4. Convert the voltages at the positions of the cursors to concentrations using the Advanced Units 

Conversion dialogue window (Figure AMe-1-S8).

5. To convert the voltages on the Expired CO2 Concentration (%) channel, click on the arrow to 

the left of the channel title to open the channel menu. Select Units from the channel menu, and 

select Advanced from the Units submenu.

Figure AMe-1-S6: The voltage outputs of the two sensors in the gas analyzer, carbon dioxide on the top

and oxygen on the bottom. Other recording windows have been minimized to show detail.

Figure AMe-1-S7: The LabScribe toolbar.

Animal Metabolism – RER – Background AMe-1-9



iW
or

x S
am

ple
 La

b

6. On the Units Conversion window:

• Make sure Apply units to the next recorded block and Apply units to all blocks are 

selected in the menu under the displayed graph on the left side of the window by putting 

a check mark in the boxes next to each statement. 

• Click on and move the cursors so that they are in position such that:

• the first 2 cursors are on the area where room air values were recorded. Leave a 

space between the cursors so that you have an average value being calculated 

while room air was moving into the GA-300 gas analyzer.

• the second 2 cursors are on the area where the gas sample values were recorded. 

Leave a space between the cursors so that you have an average value being 

calculated while the gas sample was moving into the GA-300 gas analyzer.

• Notice that the voltages from the positions between the cursors are automatically entered

into the value equations. Enter the two concentrations of carbon dioxide measured from 

the two samples in the corresponding boxes on the right side of the conversion 

equations. 

• Using room air - the concentration of CO2 = 0.04

• The second gas concentration will be the one from the gas cylinder. Generally a 5% CO
2

concentration is recommended.

• Enter the name of the units, %, in box below the concentrations.

• Click the OK button in the lower right corner of the window.

Figure AMe-1-S8: The Advanced Units Conversion dialogue window with the voltages between the 

cursors set to equal the concentrations used in calibration.
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7. Repeat Steps 4 and 5 on the Expired O2 Concentration (%) channel.

• Room air = 20.9

• Second gas concentration will be the one from the gas cylinder. Generally a 12% O
2 

concentration is recommended.

8. Click on the Save button.

Experiment AMe-1: Small Animal Respiratory Exchange Ratio (RER)

Exercise 1: Changes in CO
2 

and O
2 

in a closed chamber, and RER in an endothermic animal.

Aim: To determine mean RER of an endotherm at rest.

Procedure

1. Place the animal in the chamber and close the lid securely. 

2. Click on the Record button. Type <Mouse/Rat> in the Mark box to the right of the Mark button.

Press the Enter key on the keyboard or the Mark button to mark the recording.

3. Click the AutoScale buttons on all channels.

4. On the Expired CO2 Concentration (%) channel, notice that the CO
2
 concentration shows a 

continuous steady rise in level throughout the recording.

Note:During the first few minutes or so of the recording, the small animal chamber is filling with 

expired air from the organism inside. Since this is a closed system, the concentration of CO
2
 continues 

to rise as the animal exhales into the chamber. 

• The time that it takes the chamber to be filled with expired air and a steady increase in 

the level of carbon dioxide will depend on the volume and respiration rate of the 

organism and the volume of the small animal chamber. It will take longer to fill the 

chamber if the organism’s respiration rate and tidal volume are low, or the animal is very

small.

Warning:The CO
2
 concentration will continue to rise throughout the experiment and levels can 

become toxic to the animal in the chamber. Remove the animal immediately if the CO
2
 levels reach 

3.5%.

5. On the Expired O2 Concentration (%) channel, notice that the O
2
 concentration will show a 

steady decrease as the animal is using the O2 in the chamber. As pointed out in the previous 

step, the size of the chamber, the tidal volume, and respiration rate of the organism, determine 

the time it takes for the concentration of oxygen to decrease significantly.

6. On the RER channel, an equation programmed in the software determines RER based on the 

relative levels of CO
2
 (which is increasing) and O

2 
(which is decreasing).
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7. Continue to record until the concentration of carbon dioxide in the chamber reaches 3%.

Note: Remember to remove the animal from the chamber immediately if the carbon dioxide 

concentration reaches 3.5%.

8. Once the appropriate data is recorded, click Stop to halt the recording. Your recording should be

similar to the data displayed in Figure AMe-1-L1.

9. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 

in which to save the file, like your lab group folder. Designate the file type as *.iwxdata. 

10. Click on the Save button to save the data file.

11. Remove the animal from the chamber and place it back into its container.

12. Clean and dry the small animal chamber if necessary.

RER Channel Set Up

1. Display the complete data recording in the Main window. Use the Display Time icons to adjust 

the Display Time of the Main window to show the complete recording on the Main window. 

2. Select and display a section of data that shows the change in CO
2
 concentration at 1% (Figure 

AMe-1-L1). 

3. This can be done by:

• Clicking on and dragging the cursors to either side of the data, and looking at the V2-V1 

value in the upper right corner of the Expired CO2 channel. 

• When V2-V1 value is equal to 1%, look at the T2-T1 value in the upper right to 

determine the time it took for the CO
2
 concentration to change by 1%.

4. Click on RER Expired CO2 Concentration (%) on the RER channel. Choose Setup Function 

from the drop down list. This will open the RER Calculation Dialog window (Figure AMe-1-

L2).

5. Setup the RER calculations:

• Choose the appropriate RER Type by clicking on the down arrow and choosing Closed 

Small Animal Chamber.

• Check the O2 and CO2 channel information so that they are being calculated from the 

correct channels.

• Change the Time(s) to average to 30 seconds

• Change the Delta Time(min) to be the T2-T1 value noted in Step 2. This is the time it 

took for the CO2 concentration in the small animal chamber to change by 1%.

• Click OK.

6. The recording on the main window will now have a histogram on the RER channel.
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Figure AMe-1-L1: The recording of the expired CO2 over a period of 28 minutes showing a change in 

concentration by 1%.

Figure AMe-1-L2: RER Calculation Dialog window.
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Data Analysis

1. Scroll to the beginning of the recording where the histogram is not a straight line. You should be

able to see a step-like histogram.

2. Click and drag the cursors to either side of the step-like histogram.

3. Click the Zoom between Cursors button on the toolbar to expand this section of data to fill the 

window.

4. Click AutoScale on all channels. Your data should look like the data seen in Figure AMe-1-L3.

Figure AMe-1-L3: The RER channel showing the histogram for the ratio of CO2 to O2 in the 

endothermic organism.

5. Click on the Analysis window icon in the toolbar  or select Analysis from the Windows menu to

transfer the data displayed in the Main window to the Analysis window (Figure AMe-1-L4).

6. Look at the Function Table that is above the uppermost channel displayed in the Analysis 

window. The functions, Mean, T2-T1, and V2-V1 should appear in this table. Values for these 

parameters on each channel are seen in the table across the top margin of each channel.

7. Once the cursors are placed in the correct positions for determining the CO
2
 and O

2
 

concentrations, the values for these parameters can be recorded in the on-line notebook of 

LabScribe by typing their names and values directly into the Journal.

8. The functions in the channel pull-down menus of the Analysis window can also be used to enter

the names and values of these parameters in the Journal. To use them:
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• Place the cursors at the locations used to measure the concentrations and RER.

• Transfer the names of the mathematical functions used to determine these data to the 

Journal using the Add Title to Journal function in the Expired CO2 Channel pull-down 

menu.

9. Transfer the values for the data to the Journal using the Add All Data to Journal function in the 

Expired CO2 Channel pull-down menu.

10. Repeat this procedure for the Expired O2 Concentration (%) channel. 

11. The values for the following parameters are determined when the cursors are positioned as 

directed:

• Mean concentration of CO
2
 in expired air, which is the value for Mean on the Expired 

CO2 Concentration channel.

• Mean concentration of O
2
 in expired air, which is the value for Mean on the Expired O2 

Concentration channel.

12. Mean RER, which is the value for Mean on the RER channel. This is calculated by dividing the 

expired CO
2
 value by the expired O

2
 value to get the RER ratio as setup previously.

13. Record the T2-T1 value that is used to measure the mean values of CO
2
, O

2
 and RER.

14. Record the values in the Journal using one of the techniques described in Steps 6 or 7.

15. Record the values for the Mean CO
2
 and O

2
 concentrations in expired air in Table AMe-1-L1. 

Also record the RER and T2-T1 values.

Exercise 2: Changes in CO
2 

and O
2 

in a closed chamber, and RER in an ectothermic animal.

Aim: To determine the changes in CO
2
 and O

2
 volumes of an endotherm and make a comparison with 

the values obtained from an endotherm.

Procedure

1. Use the same procedures used in Exercise 1 to record the CO
2
, O

2
 and RER values from an 

ectotherm.

2. Place the ectotherm (lizard, frog or snake) into the clean, dry small animal chamber and close 

the lid securely.

3. Mark the recording with comments that indicate the organism in the chamber.

4. Click Record to begin the recording.

5. Record until a concentration of 3% carbon dioxide is reached.

Note: Remove the animal from the chamber immediately in the CO
2
 concentration reaches 3.5%.
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6. Click Stop to halt the recording and Save your data file.

7. Remove the animal from the chamber and place it back in its container.

RER Setup and Data Analysis

1. Use the same procedures used in Exercise 1 to set up the RER channel showing a 1% change in 

CO
2
 value.

2. Make any necessary changes on the RER channel by opening the RER Calculation dialog 

window (Figure AMe-1-L2).

3. Follow the procedures in Exercise 1 for data analysis of the beginning section of the recording 

for the ectotherm showing the step-like histogram.

4. Determine the oxygen (O
2
), carbon dioxide (CO

2
), and respiratory exchange ratio (RER) 

values. Note the T2-T1 value for the section of data with the step-like histogram.

5. Record the values for the Mean CO
2
, O

2
 concentrations, RER, and the T2-T1 value on Table 

AMe-1-L1.

Questions

1. During which experimental period was the endotherm’s expired CO
2
 the highest? In which 

period was it the lowest? 

2. During which period was the endotherm’s expired O
2
 the highest? In which period was it the 

lowest?

3. During which period did the endotherm have the highest RER? In which period was the RER 

the lowest?

4. How do the values obtained from the endothermic animal compare to those from the 

ectothermic animal?

5. How does the RER values from these organisms relate to their overall metabolic rate?

6. Does ambient temperature have anything to do with their overall metabolism?

7. What would happen to the RER values for the ectotherm if you lowered the ambient 

temperature? The ectotherm?

8. For what reason should the animal not have eaten within an hour of performing these 

experiments? Evaluate the diet of these animals. How does diet correlate to the RER values?
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Figure AMe-1-L4: The expired oxygen and carbon dioxide concentration and RER of a small animal as

displayed in the Analysis window. The cursors are in position to measure the mean values of the 

selected interval.

Optional Exercise

RER is a temperature dependent value. As an optional exercise, the animals can be cooled and RER can

be calculated as they return to normal body temperature or to room temperature.
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Table AMe-1-L13: Table for recording Mean CO2, O2 and RER values for the endothermic and 

ectothermic organisms. T2-T1 values are also recorded.

Environmental Conditions Organism
Mean Concentration (%) in 

the Chamber

Mean 

RER

Temperature 

(oC)

T2-T1 (min/sec) for RER

calculation
CO

2
O

2

Endotherm

Ectotherm

Weight Normalization Calculation

Normalized Expired O
2

O2 / [(weight(g) / mass unit)]*effective mass

Example: O2 = 0.83 ml/min, weight = 25 grams, 

mass unit = KG, effective mass factor (slope) = 0.75

O2
norm

 = 0.83 / (25/1000)0.75 = 13.2 ml/KG/min

Using an effective mass factor of 1 eliminates any effective mass correction.

This can be repeated for the CO
2 

values. When RER is calculated using normalized values, the weight 

of the organism is taken into account.
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